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[bookmark: _Toc256000001][bookmark: scroll-bookmark-1]Overview
The Option B Excel eForm is an application designed to assist you in electronically recording Pesticide Reporting Law (PRL) information and reporting it to the NYS Department of Environmental Conservation. Each time you run the program you are asked to enter or verify some basic contact information. You can then view and fill out electronic forms that are similar to the four paper forms used to report pesticide usage and sales.  The forms are customized Microsoft Excel workbooks.
Option B runs under Microsoft Windows® and requires Microsoft Excel®.
After you download the Option B installation file, see the PRL Software Installation Guide to help you install the software on your computer.

[bookmark: scroll-bookmark-2]
	After you install Option B, you must change the macro security setting in Excel.  If you do not change the security setting and enable macros, many of the features in the spreadsheets will not function correctly.  Depending on your macro security setting and version of Excel, Excel may ask if you want to enable Macros when you open these forms.  ALWAYS  enable macros when using this software. 
If Macros have not been enabled, the spreadsheets should show a prominent warning in the header area. (Note: the “Macros Disabled” warning may be briefly visible when you open a form and while you are saving a form; this is normal.)
The instructions for enabling macros are also available from the Help menu (Macro Security Setting item) on the Control Center.



If you need further assistance, contact the Pesticide Reporting Service Bureau.
[bookmark: _Toc256000002][bookmark: scroll-bookmark-3]Getting Started
There are a couple of ways1 to open up the main window:
· Double-click the "PRL Option B" shortcut on your computer’s desktop.
· Click on the Windows Start button and navigate to Programs -> Pesticide Reporting -> PRL Option B.  Windows 8 users will have a  "PRL Option B" icon on their Start Screen.
A message box saying something like “Data directory created called 'C:\PRL2011'.” may appear. This is normal. The data directory is the location to which your data files will be written.  The Control Center then opens.

Figure 1 Control Center

[bookmark: _Toc256000003][bookmark: scroll-bookmark-4]Entering Contact and Identity Information
Use the Control Center to tell us who to contact when we communicate with you about your report.  Please fill out all three fields under Pesticide Reporting Contact Person. You also need to provide identification information, so that we can associate your report with the correct applicator(s) or organization.
Are you in the pesticide application or sales business?
Pesticide application businesses should submit
· a certification ID,
· the Applicator Name associated with the certification ID,
· optionally, a business registration number, and
· optionally, the Business Name.
Pesticide applicators should submit
· a certification ID, and
· the Applicator Name associated with the certification ID.
Pesticide sales businesses should submit
· a commercial permit number,
· the Business Name,
· optionally, a certification ID, and
· optionally, the Applicator Name associated with the certification ID.
[bookmark: scroll-bookmark-5]

	Multiple Applicators or Sales Permits
If your organization employs multiple applicators, just choose one of them to enter in this form.
If your business has more than one business registration number, enter the one for the main business office. You may — but are not required to — submit the other business registration numbers using a Form 26A.  See this FAQ for more information.
If your business has more than one commercial permit number, you may enter one number here and provide separate Form 25s or Form 27s for each commercial permit number. The header areas of both forms have a commercial permit number field, which is editable.  You may also send us separate reports for each commercial permit number.
See the Multiple Applicators section for more information.


[bookmark: _Toc256000004][bookmark: scroll-bookmark-6]Decide Which Forms to Use
If you have multiple applicators to include on your report, we recommend using a Form 26A to enter their information.  The pesticide applications they made should be entered on a Form 26.  If any of the applicators that you are reporting for made any applications during the report year, you should submit a Form 26.
	You may enter all your applications in one file even if they were made by multiple applicators; we do not need a separate report for each applicator.


If you are reporting for a pesticide sales business and you sell restricted use pesticides, use Form 25.  If you sell pesticides to private applicators, we will need a Form 27.  If you have a commercial permit number, you must submit either a Form 25 or a Form 27 or both.
	Be sure to include applicators who did not make applications on your report and applicators who left your organization during the report year.   If your organization is a pesticide sales business, you must file a report even if you did not make any sales during the report year.


You can report two different types of sales on Form 25; report either sales to another commercial permit holder who will resell the products or sales to commercial applicators for their end use.  In Options A and B there are a set of radio buttons in the Form 25 header where you can specify the sales type.  Options D and O have drop down lists for specifying the sales type.  If you have both types of sales to report, please send us a separate form for each type.  However you do not need to complete a form for the type of sales you did not make (but you still need to report even if you did not make any sales).
[bookmark: _Toc256000005][bookmark: scroll-bookmark-7]Opening up a Form
When you have decided which form(s) to use, click the corresponding radio button in the Report Forms area.  Do you want to start a new file or add to an existing one? To start a new file, click on the Blank Form button.  For an existing file, click the Existing Form button.  This will open up a dialog in which you can choose the file you want.
[bookmark: _Toc256000006][bookmark: scroll-bookmark-8]More Control Center Functions
There are several buttons and menu items available on the Control Center that can help you prepare and submit your PRL report.
[bookmark: _Toc256000007][bookmark: scroll-bookmark-9]Change Report Year

	Changing the Report Year
[bookmark: scroll-bookmark-10]Background
The current report year is prominently displayed near the top of the Control Center and on each of the forms. If you are entering data for a different report year, you can change the year.
1. To do this, either click the Change Year button on the Control Center or choose the Change Year menu item on the Tools menu.
Figure 2 Change Report Year

2. Select the new year and click OK.
[bookmark: scroll-bookmark-11]Results
· If the PRLyyyy subfolder (where "yyyy" = four-digit report year) does not yet exist for the current report year, it is created.
· If the identity.txt file already exists in the report year folder, it is opened and the contents loaded into the contact and information boxes of the Control Center.
· if the identity.txt file does not exist, the contact and identity entries from the Control Center are saved to a new file.
· Report files are not automatically moved from the previous report year folder to the newly selected one.
[bookmark: scroll-bookmark-12]Keystroke Shortcuts
· Menu Item: Alt-T, Y
· Button: Alt-Y




[bookmark: _Toc256000008][bookmark: scroll-bookmark-13]Change the Report Root

	Change Report Root
[bookmark: scroll-bookmark-14]Background
Why change the report root folder?  You will probably not need to change the folder from whatever choice you made during installation. However, if you need to enter PRL reports for more than one business (e.g., if you complete PRL reports for several clients), you might find it convenient to create a separate folder for each business. This approach will help you to keep the identity information and report files for each business separate.
1. Select the Change Report Root item on the Tools menu.
2. A standard Windows dialog opens to let you select an existing folder or create a new one.
3. Click OK when you are finished.
[bookmark: scroll-bookmark-15]Results
· If the PRLyyyy subfolder (where "yyyy" = four-digit report year) does not yet exist for the current report year, it is created.
· If the identity.txt file already exists in the report year folder, it is opened and the contents loaded into the contact and information boxes of the Control Center.
· If the identity.txt file does not exist, the contact and identity entries from the Control Center are saved to a new file.
· Report files are not automatically moved from the previous report year folder to the newly selected one.
[bookmark: scroll-bookmark-16]Keystroke Shortcuts
· Menu Item: Alt-T, R




[bookmark: _Toc256000009][bookmark: scroll-bookmark-17]Save Identity
Saves the contact and identity information on the Control Center to the identity.txt file in the report year folder. Contact and identity information is automatically saved when you exit the program, open a PRL Form, or initiate an upload of your report, but this menu option lets you save the identity information whenever you want.
-> Menu Item: File –> Save (keystroke shortcut: Alt-F, S) 
[bookmark: _Toc256000010][bookmark: scroll-bookmark-18]Edit Product List
The EPA Product List is a list of pesticide products (EPA Registration Numbers and Product Names) that you use frequently when preparing PRL reports.  This command opens a dialog box with which you can create or edit your Product List.  You can also open the EPA Product List dialog from Forms 25, 26 and 27.  See EPA Registration Number List for more information.
-> Menu Item: Tools -> Edit Product List (keystroke shortcut: Alt-T, E)
[bookmark: _Toc256000011][bookmark: scroll-bookmark-19]Upload Report
The Upload Report to NYSDEC menu item/button enables you to submit your report to us when you have completed it.  See the Upload Report to NYSDEC section for more information.
-> Menu Item: Tools -> Upload Report (keystroke shortcut: Alt-T, U)
-> Button: Upload Report (keystroke shortcut: Alt-U) 
[bookmark: _Toc256000012][bookmark: scroll-bookmark-20]Background Color
Enables you to change the background color of the application's windows.
-> Menu Item: Tools -> Background Color (keystroke shortcut: Alt-T, B)
[bookmark: _Toc256000013][bookmark: scroll-bookmark-21]Help
The Help menu on the Control Center gives you access to several documents.
· How to Submit Files to DEC — opens a set of detailed instructions on submitting your report.
· User Guide — opens this guide.
· Macro Security Setting — instructions for setting the macro security level in Excel and enabling macros for the workbook.  These instructions are also accessible using the Help: Enable Macros button. 
· About — open a simple dialog box with information about the software version you are running.
[bookmark: _Toc256000014][bookmark: scroll-bookmark-22]Show Instructions
This button displays a brief set of instructions for filling out the Control Center fields.
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Exits the program.
· Menu Item: File -> Exit (keystroke shortcut: Alt-F, X)
· Button: Exit (keystroke shortcut: Alt-X)
· Close window button (top right corner of the Control Center)
· Windows menu (click the icon in the left corner of the title bar) – Close Window
Results
· If there is no missing or invalid contact or identity information, the entries are saved to the identity file in the current report folder.
· If contact or identity information is missing or invalid, you will be given a choice to correct the deficiencies or exit without saving.


[bookmark: _Toc256000016][bookmark: scroll-bookmark-24]Report Forms
The PRL report forms are where you will enter the data that you need to report to the NYSDEC. Each form is used to report a particular type of pesticide-related activity.


	IMPORTANT
The Excel eForms rely on the use of VBA Macros. ALWAYS enable macros when using this software.


Figure 3 Form 26




Figure 4 Form 26A

Figure 5 Form 27

Figure 6 Form 25


[bookmark: _Toc256000017][bookmark: scroll-bookmark-25]Identity Fields
The identity fields in the header area of each form are filled with the values you entered on the Control Center.  Changing the identity fields here does not update the corresponding fields on the Control Center.  While the certification number and applicator name are editable, there are better methods for reporting for multiple applicators.  The commercial permit number field is editable so that you can report for multiple commercial permittees  in one report submission.
Form 26A also includes a business registration number column.  If your pesticide business has more than one business registration number, you may but are not required to include all of your business’s registration numbers on the Form 26A.
[bookmark: _Toc256000018][bookmark: scroll-bookmark-26]Reporting No Activity
On each of the forms you can indicate that there was no reportable activity for the report year.
[bookmark: _Toc256000019][bookmark: scroll-bookmark-27]Excel eForms
If you have applications or sales to report, enter each pesticide application or sales record in its own row in the spreadsheet below the header area.  The header area is “frozen” — i.e., it will remain visible at the top of the spreadsheet as you scroll down through the data entry rows. Please ensure that you have scrolled up to the rows that contain data if you are editing an existing workbook.
For your convenience, if you hover over the header cell with your mouse, the column headers show a “tool tip” with a data description for that column. In addition, most of the data entry cells show a descriptive prompt when the cell is selected.  If a prompt needs to be moved, simply drag it out of the way.  Additional information about the fields in each form is available from the Data Dictionary.
You can use standard Excel methods for moving around the spreadsheet from one cell to another.

	Excel has a few surprising behaviors. If you use arrow keys or Tab to move more than one row past the part of the spreadsheet containing data, the input focus will automatically move back to the top of the worksheet instead of to the next row.



Many of the standard editing features of an Excel spreadsheet are available for your use during data entry. For example, Copy, Cut, Paste, and Clear Contents can be used to edit individual cells.  Since the eForms do not have selectable row numbers, we have provided two buttons for copying or deleting an entire row.
Values entered into cells are checked against a simple set of validation rules.  See Validation for more information.

	Ditto marks or use of the words "ditto", "same", or similar entries are not accepted by the Pesticide Reporting Service Bureau. Instead, you can use the EPA Reg Number List. or copy and paste as a convenient way to enter the same information repeatedly.


[bookmark: _Toc256000020][bookmark: scroll-bookmark-28]eForm Menus and Controls
The eForms have a set of menus and controls designed to assist you in creating your PRL report.
[bookmark: _Toc256000021][bookmark: scroll-bookmark-29]County Code Selector
The County Code Popup can be opened by clicking the yellow button at the top of the data entry grid in Forms 26 and 27.  See County Code Popup for more information.
[bookmark: _Toc256000022][bookmark: scroll-bookmark-30]Save and Save As
Use these menu items to save the report file.  See File Saving for more information.
	As the workbook is being saved, the “Macros Disabled” warning will briefly appear. This is normal and intended.


· Menu Item: File -> Save (keystroke shortcut: Alt-F, S)
· Menu Item: File -> Save As (keystroke shortcut: Alt-F, A)
[bookmark: _Toc256000023][bookmark: scroll-bookmark-31]Print and Print Selection
Prints the PRL data form or a selected region from the data entry grid.
1. Choose the Print or Print Selection menu item on the File menu (or use the keystroke shortcut).
2. A Print Preview window opens, showing you the expected printout. Click the Print button.
3. A standard Windows Print dialog lets you select a printer and change print properties as needed.
4. Click OK to print.

	Important
You will be reminded before printing that the printout is intended for your own records only.  Please do not submit the printed copy as your PRL report.


· Menu Item: File -> Print (keystroke shortcut: Alt-F, P)
· Menu Item: File -> Print Selection
[bookmark: _Toc256000024][bookmark: scroll-bookmark-32]Copy and Delete Rows
To use the Copy Row button, position the mouse on the row you wish to copy and click the Copy Row button. The row is copied to the first empty row in the spreadsheet. To use the Delete Selected Row(s) button, select any cells in the row or rows that you want to delete. Then click the button.
[bookmark: _Toc256000025][bookmark: scroll-bookmark-33]Edit EPA List
This button opens a dialog box with which you can create or edit a list of pesticide products (EPA Registration Numbers and Product Names) that you use frequently.  See EPA Registration Number List for more information.
[bookmark: _Toc256000026][bookmark: scroll-bookmark-34]Documentation
Two buttons and one link on each Option B workbook provide access to documentation files:
· User Guide — button opens this User Guide.
· How to Submit Report — button opens a set of detailed instructions on submitting your report to the DEC.
· Enabling Macros  — instructions for setting the macro security level in Excel and enabling macros for the workbook.

[bookmark: _Toc256000027][bookmark: scroll-bookmark-35]Record Layouts
See the Data Dictionary in the Appendix for more information.

Form 26 
Reporting Columns - For each product in each pesticide application, report these fields using Form 26.  All columns are required except for the End Date.
1. EPA Registration Number
2. Product Name
3. Quantity
4. Units of Measure
5. Application Date
6. End Date
7. County Code
8. Address
9. Municipality
10. Zip Code

Record Keeping Columns - These columns are optional; you may use them to fulfill the record keeping requirements of the PRL.
11. Dosage Rate
12. Method of Application
13. Target Organism(s)
14. Place of Application

Form 26A
For each commercial applicator, technician and anti-fouling applicator report these fields using Form 26A.  All columns are required.
1. Certification ID Number
2. Applicator First Name
3. Applicator Last Name
4. Applications Indicator

Form 27
For each sale of restricted use pesticides or general use agricultural pesticides to certified private applicators, report these fields using Form 27.  All columns are required.
1. EPA Registration Number
2. Product Name
3. Quantity
4. Units of Measure
5. Application Date
6. County Code
7. Address
8. Municipality
9. Zip Code

Form 25
For each container size of each restricted use pesticide sold to New York purchasers, report these fields using Form 25.  All columns are required.
1. EPA Registration Number
2. Product Name
3. Container Size Quantity
4. Container Size Units
5. Containers Sold

[bookmark: _Toc256000028][bookmark: scroll-bookmark-37]A Closer View
[bookmark: _Toc256000029][bookmark: scroll-bookmark-38]Enabling Macros in Excel
[bookmark: _Toc256000030][bookmark: scroll-bookmark-39]Background
We have provided several custom operations in the Option B Excel eForms for your convenience. These functions all require that macros be enabled.  Before you can enable macros, you must set the appropriate macro security level.
Macros can add a wide variety of custom behavior to Microsoft Excel workbooks, but they also pose a potential security risk. Consequently, each version of Excel has provided ways for users to enable or disable macros by setting the desired level of macro security from Very High to Low; the initial “default” setting provides a relatively high level of protection.
The process for enabling macros depends upon the version of Excel and whether the workbook has been digitally signed.
[bookmark: _Toc256000031][bookmark: scroll-bookmark-40]Excel 2000 - 2003
[bookmark: scroll-bookmark-41]To change the macro security level
Excel 2000 through Excel 2003 have four macro security levels.
1. Start Excel.
2. On the Tools menu, point to Macro and click Security.
3. In the Security dialog box, click the Security Level tab.
4. Select the desired macro security setting and then click OK. (Use either Medium or High for Option B.)
5. Close Excel. (The security-level changes will not take effect until Excel is restarted).
[bookmark: scroll-bookmark-42]To enable macros in the Option B workbooks
With macro security set to either High or Medium:
1. Start the Option B program (first usage, see this note).
2. Choose the type of form and open a Blank Form or reopen a previously saved Existing Form.
3. When Excel 2000 - 2003 starts, you will be presented with a Security Warning dialog box. It should indicate that the workbook contains macros by Cornell University.
· If macro security is set to High, you may only enable macros from trusted publishers. The Enable Macros button is disabled until you check “Always trust macros from this publisher”. Check the box, then select Enable Macros.
· If macro security is set to Medium, you have two choices:
· Recommended: Check “Always trust macros from this publisher”, then select Enable Macros.
· Leave “Always trust macros from this publisher” unchecked and select Enable Macros. This approach enables macros only for this workbook and only for this session. You will need to enable macros every time you open an Option B workbook.


	If you check “Always trust macros from this publisher”,you only need to do this once; from then on, all Option B forms should open with macros enabled.


[bookmark: _Toc256000032][bookmark: scroll-bookmark-43]Excel 2007
[bookmark: scroll-bookmark-44]To change the macro security level
Beginning with Excel 2007, there are still four security levels but their meanings are subtly different from those in Excel 2003 and earlier.
1. Start Excel.
2. Click the Office Button (the Windows™ logo in the upper left corner).
3. Select the Excel Options button.
4. In the left pane of the Excel Options dialog, select Trust Center.
5. Click the Trust Center Settings button in the right pane.
6. In the left pane of the Trust Center dialog, select Macro Settings.
7. In the right pane, select the desired macro security setting. (Use either of the middle two settings; it does not matter for Option B.)
8. Click OK to close the Trust Center; click OK to close Excel Options.
[bookmark: scroll-bookmark-45]To enable macros in the Option B workbooks
1. Start the Option B program (first usage, see this note).
2. Choose the type of form and open a Blank Form or reopen a previously saved Existing Form.
3. If you have not previously selected “Trust all documents from this publisher” with an Option B file, the workbook will open with macros disabled and a Security Warning bar between the Ribbon and the spreadsheet.
· Click the Options… button on the Security Warning bar.
4. The Microsoft Office Security Options dialog appears showing information about the digital signature for this form. The digital signature should be valid, but may have expired; the macros should be signed by Cornell University. You have two options:
· Recommended: Select “Trust all documents from this publisher”. (Not available if the signature has expired.) From now on, all Option B workbooks should open with macros enabled.
· Select “Enable this content”. You will need to enable macros the same way every time you open an Option B workbook.
5. Select OK to close the Security Options dialog.
[bookmark: _Toc256000033][bookmark: scroll-bookmark-47]Excel 2010 - 2013
[bookmark: scroll-bookmark-48]To change the macro security level
Beginning with Excel 2007, there are still four security levels but their meanings are subtly different from those in Excel 2003 and earlier.
1. Start Excel.
2. Open the File menu9.
3. Select the Options button.
4. In the left pane of the Excel Options dialog, select Trust Center.
5. Click the Trust Center Settings button in the right pane.
6. In the left pane of the Trust Center dialog, select Macro Settings.
7. In the right pane, select the desired macro security setting. (Use either of the middle two settings; it does not matter for Option B.)
8. Click OK to close the Trust Center; click OK to close Excel Options.
[bookmark: scroll-bookmark-49]To enable macros in the Option B workbooks
1. Start the Option B program (first usage, see this note).
2. Choose the type of form and open a Blank Form or reopen a previously saved Existing Form.
3. If you have not previously selected “Trust all documents from this publisher” with an Option B file, the workbook will open with macros disabled and a Security Warning bar between the Ribbon and the spreadsheet.
a. Do Not select the Enable Content button in the Security Warning bar; that will enable macros only for this document. Instead, click the “Macros have been disabled” text to the left of the button (or open Info from the File menu).
b. In the Security Warning section of the Info screen, click the Enable Content drop-down button and choose Advanced Options.
4. The Microsoft Office Security Options dialog appears showing information about the digital signature for this form. The digital signature should be valid, but may have expired; the macros should be signed by Cornell University. You have two options:
· Recommended: Select “Trust all documents from this publisher”. (Not available if the signature has expired.) From now on, all Option B workbooks should open with macros enabled.
· Select “Enable content for this session”. You will need to enable macros the same way every time you open an Option B workbook.
5. Select OK to close the Security Options dialog.
[bookmark: _Toc256000034][bookmark: scroll-bookmark-50]Reporting for Multiple Applicators
If your business employs multiple applicators, you can submit a single report on behalf of all of the applicators employed by your business during the report year.  There are there methods of doing this.

	Unless all of the applicators on whose behalf you are reporting made no pesticide applications during the report year, you must include at least one Form 26 regardless of which of the three methods you use.


[bookmark: _Toc256000035][bookmark: scroll-bookmark-51]Compatibility
Option A: Methods 1, 2
Option B: Methods 1, 3
[bookmark: _Toc256000036][bookmark: scroll-bookmark-52]Method 1 - Recommended

1. Enter the name and certification number of one applicator on the Control Center.
	It does not matter which of your business’s applicators you enter on the Control Center; however, if your company has one applicator with primary supervisory responsibility over other applicators, that applicator would be a reasonable choice.


2. Fill out or create a Form 26A listing all applicators employed by your business during the report year, whether or not they made any pesticide applications.
3. Fill out or create a Form 26 for all reportable pesticide applications made by all your applicators.
	The information on the  Control Center does not need to be changed to report for multiple applicators.  Normally, when you open a blank Form 26, the certification number on the Control Center is copied to the new Form 26. This is acceptable, even though the applicator shown might not have personally performed all (or even any) of the pesticide applications reported or supervised the making of those applications.


[bookmark: _Toc256000037][bookmark: scroll-bookmark-53]Method 2

Although it is not required by the DEC, you may maintain a separate Form 26 for each applicator entered on Form 26A.
1. On the Control Center check the box labeled “Check here if you wish to maintain separate application files …”.
2. A list of the applicators from your Form 26A will be shown (see Multiple Applicators image).
3. Select one of the applicators.  The name and certification ID of the applicator you select will be written to the header area of the empty Form 26.

Figure 7 Multiple Applicators

[bookmark: _Toc256000038][bookmark: scroll-bookmark-54]Method 3

If you are using Option B, you can create separate Form 26s for each applicator:
1. Enter the name and certification number of one applicator on the Control Center.
2. Create a separate Form 26 for each applicator.
3. Change the  certification number and applicator name in the header of each Form 26.
4. Saving the form will save the name and ID of the applicator with that Form 26 file.


[bookmark: _Toc256000039][bookmark: scroll-bookmark-55]No Applications or Sales

All applicators, even if they did not make applications, must be included on a  PRL report.  Form 26A has a column to record whether the applicator made applications.  If you are reporting for a single applicator who did not make applications, use the No Commercial Applications Were Made This Year check box  (a drop down list in Options D and O) in the header area of Form 26 or submit your report on our web site.
All commercial sales organizations must include each of their commercial permit numbers on a PRL report, even if they did not make any pesticide sales during the year.  Form 27 includes a check box or a drop down list in the form header with which you can indicate that no sales were made during the year.  Form 25 includes a set of radio buttons or a drop down list that has the No Sales Were Made This Year item selected by default.

[bookmark: _Toc256000040][bookmark: scroll-bookmark-56]EPA Registration Number List

[bookmark: _Toc256000041][bookmark: scroll-bookmark-57]Editing the List
The EPA Registration Number List simplifies the data entry of products that are used multiple times.
When you open one of the pesticide sales or application forms (Forms 25, 26 and 27) you will see the list in the upper right corner of the form.  Open up the list by clicking the Edit button on one of the forms or choosing the Edit Product List item on the Tools menu of the Control Center. In Option A you can also open the edit window by choosing the Edit List item from the Product List menu.

Figure 8 Product List Dialog


On the Product List that opens up, add products by
1. clicking Add,
2. typing the EPA Registration Number and the Product Name in the window that opens up, and
3. clicking OK to save.  (see Temporary or Permanent Changes? for more information)
[bookmark: scroll-bookmark-58]Other EPA List Functions
· Edit an existing entry - Select the entry, then click the Edit button.
· Remove a single entry from the list - Select the entry, then click the Delete button.
· Remove all items from the list - click the Clear button.
· Restore the list from the permanent file - click the Reload button.
· Make your changes permanent - click Save.


	Temporary or Permanent Changes?
If you do not Save your changes, they will remain in effect until you close the application, but they will not be permanent.  The next time you open the program, the list will be restored to its prior state.  So if you Clear the list, but do not Save it, you can always Reload it.


[bookmark: _Toc256000042][bookmark: scroll-bookmark-59]Using the List on a PRL Form
1. Exit the Product List.
2. Click in the EPA Reg Number column in a row on the form, and then click an EPA Number in the list.  On Option A you can also use the list with these keystrokes: ALT-P, L.  You can then use the arrow keys to navigate to the product you want and the enter key to select it
[bookmark: scroll-bookmark-60]Results
The EPA Number and Product Name will be populated to the row on the form.
[bookmark: _Toc256000043][bookmark: scroll-bookmark-61]County Code Popup
Forms 26 and 27 have a column for County Code.  A list of New York county codes is in the Appendix.
As an added convenience, a popup dialog is available to help you select the correct county code.
[bookmark: _Toc256000044][bookmark: scroll-bookmark-62]Using the County Popup

Figure 9 County Code Dialog



1. The county code popup can be opened by either clicking the yellow button at the top of the grid or (if the popup is enabled) by clicking or moving into the county column.
2. The county code popup has three different modes:
· Select from List: This mode enables the county code popup. Simply click the appropriate county with your mouse and the county code will be filled in on the form. The pop-up will appear every time you enter the county code field on forms 26 or 27.
· Disabled: This mode deactivates the county code popup so that you can type in the code directly on the grid.
· Select a Default Code: This mode deactivates the county code popup, but it also allows you to set a default value. The code will be entered automatically each time you enter the field. Just select a code from the list or type one in the space provided (this field is only visible when you click the radio button for this mode).
	In Option A forms the button at the top of the grid on the form also indicates the current mode of the popup.


[bookmark: _Toc256000045][bookmark: scroll-bookmark-63]Validation


	Option A - When you hover the mouse over a cell or click in a cell, the data description for the column is displayed.
Option B - When you hover the mouse over the column header, the data description for the column is displayed. Review this description if you are unsure of why a cell failed validation.  Cell descriptions are also displayed if you click in a cell.  Note that these descriptive prompts can be dragged to another location if you need to move them.


Option A makes available all validation methods listed below; Option B makes the first two available.  Option A can also validate files you created using other software applications.  For step-by-step instructions on using Option A to validate your files, see text file validation steps.
[bookmark: _Toc256000046][bookmark: scroll-bookmark-64]Validation During Data Entry
1. As you are entering data into a form, the program validates your entries.
2. If an entry fails validation, the program displays a pop-up dialog describing the error; the cell color is also set to pink after you click OK in the dialog and the cursor returns to the field.  Sometimes the invalid entry is erased.

On Option B forms a warning message, “One or more cells contain Invalid Entries”, will appear in the header area of the form.
3. You do not need to correct the error to continue entering data in the form, but should correct all errors before submitting your report.
	This method does not validate cells in which you did not make an entry.  Since most columns are required, you should use one of the two methods listed below in order to validate the whole file.


[bookmark: _Toc256000047][bookmark: scroll-bookmark-65]Validation When Saving a File
1. When you save the file, the program asks whether you would like to validate the file first.
2. If you choose Yes, cells which do not pass validation will be displayed with a pink background.

On Option B forms a warning message, “One or more cells contain Invalid Entries”, will appear in the header area of the form.
3. Find and correct the highlighted cells.
[bookmark: _Toc256000048][bookmark: scroll-bookmark-66]Validation Using the Validate Menu Item (Option A only)
1. At any time you can validate the data you have entered by clicking the Validate menu item.
2. If there are errors, the program displays a dialog with the error count and highlights the cells.
3. Find and correct the highlighted cells.
[bookmark: _Toc256000049][bookmark: scroll-bookmark-67]Validation When Opening a File (Option A only)
When you open an existing file, it is automatically validated. For files that require more than a second or two to validate, a progress bar dialog is displayed.  The dialog contains a Stop button, which you can use to cancel the validation process.  The file will still open if you cancel validation.
If errors are found, then another dialog will display the number of errors found.   After you click OK, the file will be opened and the cells with errors will be highlighted.


	Important
Files submitted with errors may be rejected by or returned from the Pesticide Reporting Service Bureau.  Please correct all validation errors.  Contact us if you need help with the validation process or making corrections to your report.





[bookmark: _Toc256000050][bookmark: scroll-bookmark-68]File Saving
The Save command writes the data in the data entry grid or workbook, along with appropriate entries from the form header, to a text file (Option A) or Excel file (Option B).  Save As is similar but gives you the opportunity to change the file name.  When you close the data entry grid or workbook, you will be given a chance to save and/or validate your data.
If you choose to save the same data several times to different files — for example, if you save the file, edit it by adding more data, then save it again with a different name — please submit only the final version with your report.  Please avoid submitting duplicate pesticide application or sales records.
	We recommend that you do not unnecessarily change the folder when saving your files. Submitting your report will be much simpler if all of your report files are in one place.  In addition, the identity information from the Control Center is always stored in the default report folder.  If you need to keep several separate reports on one computer, you can always change the report root.


[bookmark: _Toc256000051][bookmark: scroll-bookmark-69]Saving a File for the First Time or Using  Save As
1. Choose the Save or Save As menu item on the Tools menu.
	If you are using Option B, some versions of Excel may present a message warning you that the file is read-only. Click OK in the dialog.


2. A dialog will ask if you want to Validate the file before saving it.  If you choose to validate the file, you can still save regardless of whether there are errors.
3. A standard Windows Save or Save As dialog opens the report folder with the File Name field pre-filled with the recommended name.
	You may change the name of the file when you save it. However, keep the first letter (P, A, M, or S) and the file extension (either .txt or .xls) from the suggested name. The Pesticide Reporting Service Bureau requires the initial letter in order to identify the form type and the file extension to identify the file type.


4. Click Save.
[bookmark: _Toc256000052][bookmark: scroll-bookmark-70]Saving a File that Was Previously Saved
1. Choose the Save menu item on the Tools menu.
2. A dialog will ask if you want to Validate the file before saving it.  If you choose to validate the file, you can still save regardless of whether there are errors.  If you do not, the file is saved in its current location with the same file name as was last used.

[bookmark: scroll-bookmark-71]Keystroke Shortcuts
· Save menu Item: Alt-F, S
· Save As menu Item: Alt-F, A
[bookmark: _Toc256000053][bookmark: scroll-bookmark-72]Upload Your Report
[bookmark: _Toc256000054][bookmark: scroll-bookmark-73]How to Submit Your Report
1. When you are ready to submit your report to the NYSDEC, either click the Upload Report to NYSDEC button on the Control Center or choose the Upload Report item on the Tools menu.
2. If you saved your files in the default report folder, click "Yes" on the dialog box that pops-up.  Otherwise click "No" and navigate to the location where you saved your files.
3. The program then displays the Upload Utility form.  Simply uncheck files that you do not want to send us.

Figure 10 Upload Utility Form

	The contact and identity information you typed into the Control Center are saved in a file called identity.txt.  This file is not displayed in the Upload Utility form, but it is automatically included with the files you submit.  



4. Click the Step 2. Upload Report to DEC button.  The upload may take a few minutes.  If it succeeds, you will see a page with a list of the uploaded files and a submission number.

Figure 11 Upload Response Dialog

	Please make a note of the submission number; if you contact the Pesticide Reporting Service Bureau, we will need it to access your report.


5. If you do not see this page, you may see a page asking you to correct one or more of the ID numbers you entered on the Control Center.  After you correct the IDs, re-try the upload.

6. When you are finished, check your email account for a message from prlsupport@nysprl.com.  You should receive an email from us which confirms the receipt of your report and contains important information about the report that you should review.


	Upload Error
If no page is displayed after a few minutes, there is a technical problem with the upload.  Rather than using the program to upload your report, choose another submission method.



[bookmark: _Toc256000055][bookmark: scroll-bookmark-74]Keystroke Shortcuts
· Menu Item: Tools -> Upload Report (keystroke shortcut: Alt-T, U)
· Button: Upload Report to NYSDEC (keystroke shortcut: Alt-U)
[bookmark: _Toc256000056][bookmark: scroll-bookmark-75]Contact Us
[bookmark: scroll-bookmark-76]The Pesticide Reporting Service Bureau at Cornell University provides technical support to assist you in installing and using the electronic reporting programs and submitting your PRL reports.
Phone:
800-281-7538 (toll free in New York State)
607-257-5707 (a toll call) outside of New York State
Both numbers are answered Monday–Friday 9:30–5:30 and have voice mail.
Email: prlsupport@nysprl.comhttp://nysprl.com
Web Site: www.nysprl.com

[bookmark: scroll-bookmark-77]You may also contact the NYS DEC Bureau of Pest Management for technical support or other questions related to the Pesticide Reporting Law and reporting requirements:
Phone: 518-402-8748 (Monday-Friday 8:30-4:45)
Email: prl@dec.ny.gov
Web Site: www.dec.ny.gov/chemical/27506.html
[bookmark: _Toc256000057][bookmark: scroll-bookmark-78]Appendix
[bookmark: _Toc256000058][bookmark: scroll-bookmark-79]New York State County Codes

	Code
	County
	Code
	County
	Code
	County

	01
	Albany
	23
	Lewis
	45
	Seneca

	02
	Allegany
	24
	Livingston
	46
	Steuben

	03
	Broome
	25
	Madison
	47
	Suffolk

	04
	Cattaraugus
	26
	Monroe
	48
	Sullivan

	05
	Cayuga
	27
	Montgomery
	49
	Tioga

	06
	Chautauqua
	28
	Nassau
	50
	Tompkins

	07
	Chemung
	29
	Niagara
	51
	Ulster

	08
	Chenango
	30
	Oneida
	52
	Warren

	09
	Clinton
	31
	Onondaga
	53
	Washington

	10
	Columbia
	32
	Ontario
	54
	Wayne

	11
	Cortland
	33
	Orange
	55
	Westchester

	12
	Delaware
	34
	Orleans
	56
	Wyoming

	13
	Dutchess
	35
	Oswego
	57
	Yates

	14
	Erie
	36
	Otsego
	58
	Bronx

	15
	Essex
	37
	Putnam
	59
	Kings

	16
	Franklin
	38
	Rensselaer
	60
	New York

	17
	Fulton
	39
	Rockland
	61
	Queens

	18
	Genesee
	40
	St. Lawrence
	62
	Richmond

	19
	Greene
	41
	Saratoga
	99
	Out of State

	20
	Hamilton
	42
	Schenectady
	
	

	21
	Herkimer
	43
	Schoharie
	
	

	22
	Jefferson
	44
	Schuyler
	
	


[bookmark: _Toc256000059][bookmark: scroll-bookmark-80]Data Dictionary
This dictionary describes the contents of each column on each of the four PRL forms or files if your report consists of files created by a third-party application or manually.   It also gives the sequence of columns or record layout for each form type.
	The attributes in the dictionary entries are
Forms: the form type on which the column appears.
Third-Party Software Files: the text file type on which the field/column appears.  This attribute only applies to files you created without using our software.
Required: is the column optional or required.
Column Type: Columns can either be reporting, record-keeping columns.  Reporting columns contain data that must be submitted to NYSDEC under the PRL; record-keeping columns are data that you are required to maintain but do not have to submit.  You are not required to use our software to retain these data items.
Maximum Width: maximum allowable width for the column.
Data Type: the type of data that the column should contain.  See the data type descriptions for more information.
Domain: the set of allowable values.
       Notes: additional information about the column.


Form 26 
Reporting Columns - For each product in each pesticide application, report these fields using Form 26.  All columns are required except for the End Date.
1. EPA Registration Number
2. Product Name
3. Quantity
4. Units of Measure
5. Application Date
6. End Date
7. County Code
8. Address
9. Municipality
10. Zip Code

Record Keeping Columns - These columns are optional; you may use them to fulfill the record keeping requirements of the PRL.
11. Dosage Rate
12. Method of Application
13. Target Organism(s)
14. Place of Application

Form 26A
For each commercial applicator, technician and anti-fouling applicator report these fields using Form 26A.

Option A - All columns are usually required (non-registered businesses making pesticide applications (such as a golf course, cemetery, greenhouse, etc.) may omit the Business Registration Number).
1. Certification ID Number
2. Business Registration Number
3. Applicator First Name
4. Applicator Last Name
5. Applications Indicator

Option B - All columns are required.
1. Certification ID Number
2. Applicator First Name
3. Applicator Last Name
4. Applications Indicator
Form 27
For each sale of restricted use pesticides or general use agricultural pesticides to certified private applicators, report these fields using Form 27.  All columns are required.
1. EPA Registration Number
2. Product Name
3. Quantity
4. Units of Measure
5. Application Date
6. County Code
7. Address
8. Municipality
9. Zip Code

Form 25
For each container size of each restricted use pesticide sold to New York purchasers, report these fields using Form 25.  All columns are required.
1. EPA Registration Number
2. Product Name
3. Container Size Quantity
4. Container Size Units
5. Containers Sold
[bookmark: _Toc256000060][bookmark: scroll-bookmark-83]Column Descriptions

[bookmark: scroll-bookmark-84]Address
Report the street address including the building or lot number where the pesticide was applied or the purchaser intended to apply.  We cannot accept P.O. Boxes in this column.
Forms: 26, 27
Third-Party Software Files: 26, 27
Required: yes
Column Type: reporting
Maximum Width: 50
Data Type: Character
[bookmark: scroll-bookmark-85]Applications Indicator
Indicates whether or not this applicator made pesticide applications in the report year.
Forms: 26A
Third-Party Software Files: 26, 26A
Required: yes
Column Type: reporting
Maximum Width: 1
Data Type: Numeric
Domain: Option A: check the box if no applications were made.
Option B: “Y” if applications were made; “N” if no applications were made.
Third-Party Software Files: “0” if applications were made; “3” if no applications were made.  If column set to “3”, all other fields except Certification ID and Business Registration must be empty.

[bookmark: scroll-bookmark-88]Applicator First Name
First name and middle name (if reported) of the  commercial applicator, technician, or anti-fouling paint applicator employed by the registered business, privately-owned golf course, cemetery, greenhouse or private school.
Forms: 26A
Third-Party Software Files: 26A
Required: yes
Column Type: reporting
Maximum Width: 15
Data Type: Character
[bookmark: scroll-bookmark-89]Applicator Last Name
Last name of the  commercial applicator, technician, or anti-fouling paint applicator employed by the registered business, privately-owned golf course, cemetery, greenhouse or private school.
Forms: 26A
Third-Party Software Files: 26A
Required: yes
Column Type: reporting
Maximum Width: 25
Data Type: Character
[bookmark: scroll-bookmark-87]Business Registration Number
The ID number issued to pesticide application businesses or agencies by the DEC.  The field must contain 5 numeric digits (e.g. 52197).
Forms: 26A
Third-Party Software Files: 26, 26A
Required: In most cases this field is required. An exception was made to this requirement to allow privately-owned golf courses, cemeteries, greenhouses and private schools to report using form 26A.
Column Type: reporting
Maximum Width: 5
Data Type: Numeric
[bookmark: scroll-bookmark-86]Certification ID Number
The certification ID is issued by the NYSDEC to a commercial applicator, technician, or anti-fouling paint applicator. (Private applicators are also issued certification IDs but are not required to submit PRL Reports.)  The number is printed on the applicator's ID card and the certification certificate.  The certification ID number begins with “C”, “T”, or “B”, followed by 7-digits.
Forms: 26A
Third-Party Software Files: 26, 26A
Required: yes
Column Type: reporting
Maximum Width: 8
Data Type: Character
[bookmark: scroll-bookmark-94]Commercial Permit Number
The ID number issued to the Commercial Sales Permittee by the DEC. The field must contain the letter “R” followed by 5 numeric digits. (e.g. R00001).
Forms: none
Third-Party Software Files: 25, 27
Required: yes
Column Type: reporting
Maximum Width: 6
Data Type: Character
[bookmark: scroll-bookmark-95]Container Size Quantity
The numeric component of the container size for the containers that were sold. For example, if you sold 10 containers that were 2.5 gallons a piece, the Container Size Quantity is 2.5. Use only numbers and, if applicable, a decimal point in this column.
Forms: 25
Third-Party Software Files: 25
Required: yes
Column Type: reporting
Maximum Width: 6
Data Type: Decimal
[bookmark: scroll-bookmark-96]Containers Sold
The number of containers of the product that were sold.  For example, if you sold 10 containers that were 2.5 gallons a piece, the Containers Sold is 10.  Integers only; do not include decimal digits in this column.
Forms: 25
Third-Party Software Files: 25
Required: yes
Column Type: reporting
Maximum Width: 8
Data Type: Numeric
	Do not report the number of cases sold or the number of containers per case.


[bookmark: scroll-bookmark-97]County Code
The county where the application was made (Form 26) or where the private applicator intends to apply the pesticide (Form 27).  A list of county codes is included in the appendix. As an added convenience, a county code popup dialog is available in Options A and B to help you select the correct county code.
For applications that cross a county, municipality, township, or zip code boundaries, you must enter complete information for each location where the pesticide application occurred or will occur. Do this by entering a new row for each separate location. Distribute the total amount applied (or intended to be applied) among the rows, making your best estimate for how much was or will be applied in each location.
Forms: 26, 27
Third-Party Software Files: 26, 27
Required: yes
Column Type: reporting
Maximum Width: 2
Data Type: Numeric
[bookmark: scroll-bookmark-98]Date(s)
The date of application (Form 26) or the date the product was sold (Form 27). Date values must be entered in one of these formats (where mm=month, dd=day, yyyy=year):
-> mm/dd/yyyy
-> mm-dd-yyyy
-> mm-dd
-> mm/dd
Form 26 includes an End Date column that is used to specify the end of a date range where the Application Date is the beginning of the range.  This column is for automated applications (e.g. cooling towers, water treatment facilities). Leave this column blank if you do not make automated applications.
Forms: 26, 27
Third-Party Software Files: 26, 27
Required: Application Date, Sales Date: yes; End Date: no
Column Type: reporting
Maximum Width: 10
Data Type: Date
	Two-digit years are also accepted.  If the year is omitted, the application will use the report year.


[bookmark: scroll-bookmark-99]Dosage Rate
Enter the amount of pesticide used for a given application; e.g., 1 fluid ounce/gallon (FL/GL); 1 gram/12 inches (GM/IN), etc. (This is the premix or final mix dosage rate listed on the pesticide label.)
Forms: 26
Third-Party Software Files: none
Required: no
Column Type: record keeping
Maximum Width: 50
Data Type: Character
[bookmark: scroll-bookmark-100]Enduse/Resale Indicator(s)
Indicates whether the sales on Form 25 are to other commercial permit holders for resale or to certified applicators for end use.
Forms: 25
Third-Party Software Files: 25
Required: yes
Column Type: reporting
Maximum Width: 1
Data Type: Character
Domain: Third-Party Software Files - there are separate fields for each indicator.  Enter "X" in either the end use or resale field, but not both.
Option A & B - click the radio button that corresponds to the appropriate sales type.
[bookmark: scroll-bookmark-101]EPA Registration Number
Report the EPA Registration Number, exactly as it appears on the product label. It is a two or three part number in which the parts are separated by hyphens or dashes (e.g. 3125-474-538 or 3125-474).  The first part may have up to six digits, the second up to five, and the third optional part up to six.  Do not include any leading zeroes (e.g. 3125-474, not 003125-00474).
This column and the Product Name can be filled in by selecting a product in the EPA Reg Number List (Options A & B) or by typing in the cell.
Forms: 25, 26, 27
Third-Party Software Files: 25, 26, 27
Required: yes
Column Type: reporting
Maximum Width: 24
Data Type: Character

	Important
Be sure to enter the EPA Registration Number. and not the EPA Establishment Number.  Establishment Numbers have a state abbreviation as the second part of the number (e.g. 99999-NY-002).


[bookmark: scroll-bookmark-102]Method of Application
Method used to apply the pesticide (broadcast, hand placement, aerial, etc.)
Forms: 26
Third-Party Software Files: none
Required: no
Column Type: record keeping
Maximum Width: 50
Data Type: Character
[bookmark: scroll-bookmark-103]Municipality
Report the village, town or city where the pesticide was applied  (Form 26) or the purchaser intended to apply the pesticide (Form 27).  The municipality name should match the zip code (e.g., 11375 should be Forest Hills and not Queens).
For applications that cross a county, municipality, township, or zip code boundaries, you must enter complete information for each location where the pesticide application occurred or will occur. Do this by entering a new row for each separate location. Distribute the total amount applied (or intended to be applied) among the rows, making your best estimate for how much was or will be applied in each location.
Forms: 26, 27
Third-Party Software Files: 26, 27
Required: yes
Column Type: reporting
Maximum Width: 30
Data Type: Character
[bookmark: scroll-bookmark-104]Place of Application
Enter the specific location where the pesticide was applied (e.g. greens 3 & 7 of golf course; front lawn area, restaurant kitchen, etc.)
Forms: 26
Third-Party Software Files: none
Required: no
Column Type: record keeping
Maximum Width: 50
Data Type: Character
[bookmark: scroll-bookmark-105]Product Name
Report the registered product name (not the active ingredient name).  This column and the EPA Registration Number can be filled in by selecting a product in the EPA Reg Number List (Option A & B) or by typing in the cell.
Forms: 25, 26, 27
Third-Party Software Files: 25, 26, 27
Required: yes
Column Type: reporting
Maximum Width: 65
Data Type: Character
[bookmark: scroll-bookmark-106]Quantity Applied
The undiluted amount of pesticide applied; that is the amount of product used out of the manufacturer’s container.  Convert all fractions to decimals (e.g. 3/4 = 0.75).
Forms: 26
Third-Party Software Files: 26
Required: yes
Column Type: reporting
Maximum Width: 13
Data Type: Decimal
[bookmark: scroll-bookmark-107]Quantity Sold
The size of the container sold multiplied by the number of containers.  Convert all fractions to decimals (e.g. 3/4 = 0.75).
Forms: 27
Third-Party Software Files: 27
Required: yes
Column Type: reporting
Maximum Width: 13
Data Type: Decimal
[bookmark: scroll-bookmark-108]Sales Indicator
Indicates whether a pesticide sales permittee made sales during the report year.
Forms: none
Third-Party Software Files: 25, 27
Required: yes
Column Type: reporting
Maximum Width: 1
Data Type: Numeric
Domain: “0” if sales were made; “3” if no sales were made.
Notes:  If column set to “3” (No Sales), all other fields except Commercial Permit Number must be empty.
[bookmark: scroll-bookmark-109]Target Organism(s)
Enter the name of the targeted pest(s). The targeted pest or organism must be listed on the pesticide label.
Forms: 26
Third-Party Software Files: none
Required: no
Column Type: record keeping
Maximum Width: 50
Data Type: Character
[bookmark: scroll-bookmark-110]Units or Container Size Units
The unit of measure applicable to the quantity applied or  sold.
Accepted Units of Measure...
FL: Fluid Ounces
GL: Gallons
GM: Grams
KG: Kilograms
L: Liters
LB: Pounds
MG: Milligrams
ML: Milliliters
OZ: Dry Ounces
QT: Quart
In Options A, B and D the Units column on Forms 26 and 27 and the Container Size Units column on Form 25 have a drop-down list for easy entry of units. To use the list, click or tab into the cell, then click the  downward-pointing arrowhead and select one of the units.
Forms: 25,26, 27
Third-Party Software Files: 25, 26, 27
Required: yes
Column Type: reporting
Maximum Width: 2
Data Type: Character
	Only the units listed in the drop-down list can be accepted.  Please do not enter values such as "each" or "case" which cannot be converted into a specific unit of measurement.


[bookmark: scroll-bookmark-111]Zip Code
The five-digit zip code where the pesticide was applied (Form 26) or where the applicator intended to apply the pesticide (Form 27).
For applications that cross a county, municipality, township, or zip code boundaries, you must enter complete information for each location where the pesticide application occurred or will occur. Do this by entering a new row for each separate location. Distribute the total amount applied (or intended to be applied) among the rows, making your best estimate for how much was or will be applied in each location.
Forms: 26, 27
Third-Party Software Files: 26, 27
Required: yes
Column Type: reporting
Maximum Width: 5
Data Type: Numeric

[bookmark: _Toc256000061][bookmark: scroll-bookmark-81]Data Type Descriptions
· Character: Any printable ASCII character(s).
· Date: One of these formats (where m = month, d = day, y = year)
· mm/dd/yyyy
· mm-dd-yyyy
· mm/dd/yy
· mm-dd-yy
· mm/dd
· mm-dd
· Numeric: 0 – 9
· Decimal: 0 – 9 and an optional decimal point (“.”).
For numeric fields that include decimals, a decimal point and up to 4 digits to the right of the decimal point are accepted.
[bookmark: _Toc256000062][bookmark: scroll-bookmark-112]File Naming

	Option A & B
Unless you have a compelling reason to change the recommended file name, we suggest that you accept the default choice.



[bookmark: _Toc256000063][bookmark: scroll-bookmark-113]File Name Pattern
The name given to a new report file by  Option A or B, and the one recommended for third-party or manually-created text files, follows the pattern of: form prefix + ID number + sequence number + extension.
[bookmark: scroll-bookmark-114]The form prefix is the first letter of the file name, which is associated with one of the four form types:
· P - Form 26,
· A - Form 26A,
· M - Form 25, or
· S - Form 27.
The next 5 to 8 characters of the file name is a DEC-issued ID number.  The ID number used is based on the form type of the file:
· Form 25 and 27 - commercial permit number,
· Form 26 - certification ID, or
· Form 26A - either the business registration number (if any) or certification ID.
The next two digits are an (optional) unique sequence number between 00 and 99.
The last part is the extension of ".txt" ( Option A or C) or ".xls" ( Option B), which identifies the file as text or an Excel file.
[bookmark: scroll-bookmark-115]Example
If you are using  Option A and save a Form 26 file in a folder already containing another Form 26 file and both files have a Certification ID number of C1234567, the file would be named PC123456701.txt.

	Important
If you decide to use a different name, the first letter of the file name must still match the form type and use the correct extension for the software option as shown above; the initial letter is used by the Pesticide Reporting Service Bureau to identify the type of form that was submitted and the extension identifies the file type.


[bookmark: _Toc256000064][bookmark: scroll-bookmark-116]Glossary
This glossary defines the terms used in the PRL Documentation set.

[bookmark: scroll-bookmark-117]Aquatic Anti-fouling Paint Applicator: Someone who is certified in the commercial application of general use aquatic anti-foulant paints.  Anti-fouling applicators are issued an identification number that starts with the letter "B" followed by 7-digits.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-118]Business Registration Number: Business registration numbers are issued by the NYSDEC to registered businesses.  The identification number is 5-digits in length.

[bookmark: scroll-bookmark-120]Certification Identification Number:The certification ID is issued by the NYSDEC to a commercial applicator, technician, or anti-fouling paint applicator. (Private applicators are also issued certification IDs but are not required to submit PRL Reports.)  The number is printed on the applicator's ID card and the certification certificate.  The certification ID number begins with “C”, “T”, or “B”, followed by 7-digits.



[bookmark: scroll-bookmark-125]Certified Applicator: A pesticide applicator licensed by the state of New York.  This includes commercial applicators, technicians, anti-fouling paint applicators and private applicators.  Note that private applicators are not required to submit PRL Reports.


[bookmark: scroll-bookmark-126]Commercial Permit Number: Commercial sales permit numbers are issued by the NYSDEC to commercial permittees; they consist of an “R” followed by 5-digits  (e.g. R00001).

[bookmark: scroll-bookmark-121]Commercial Pesticide Applicator: Someone who is fully certified to make applications in the state of New York.  Commercial applicators are issued an identification number that starts with the letter "C" followed by 7-digits.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-128]Commercial Pesticide Apprentice: Uncertified pesticide applicator working under the direct supervision of a commercial pesticide applicator.  Apprentices do not have an identification number issued by the DEC.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-122]Commercial Pesticide Technician: Someone who is certified to make some types of applications in the state of New York.  Technicians are issued an identification number that starts with the letter "T" followed by 7-digits.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-127]Commercial Sales Permittee: Anyone who sells restricted use pesticides must hold a commercial sales permit issued by the NYSDEC.  Sales permittees are issued a commercial permit number.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-129]Compliant Report:  A PRL report file has a "compliant” format if it is either:
· A text file formatted according to the Text File Specifications.  This includes Option A files, and third-party software files or manually- created files that has been validated with our software .
· A Microsoft Excel .xls file created from one of the Excel workbooks provided by the Service Bureau.  This includes  Option B and Option D files and our "Excel-compatible" spreadsheets.
In addition, the file name should follow the naming conventions shown for  text files or Excel files, as applicable. The critical parts of the file name are the prefix and extension.
In both cases, we know how the data is laid out in the file, so we are able to automatically extract the data for storage in a database. Files that are “not compliant” require manual processing to convert them into a compliant format.
A PRL Report Submission is “compliant” if all of the files in the submission are compliant.

[bookmark: scroll-bookmark-130]Confirmation of Receipt Email (also known as First Email):  The email sent by the Pesticide Reporting Service Bureau which indicates that your report submission has been received.  It contains a list of the files we received, your submission number and a preliminary assessment of whether your report meets our specifications.  For reports submitted via the web and the PRL reporting software the email is sent immediately.  For emailed reports the receipt email will generally be sent by the next business day during the peak reporting season (roughly mid-December through early February); at other times of the year, it will be sent within a few days.  Receipt emails are not usually sent for mailed or FTPed reports.
Please retain this email as proof that your report was received.

[bookmark: scroll-bookmark-134]Form 25 (also known as Form 44-15-25): Form 25 is used by commercial permittees to report a summary of all sales of restricted use pesticides sold from their establishment to New York purchasers throughout the year. The same form is used for sales to resellers (other commercial permittees) or for sales for end use by commercial applicators, technicians, and anti-fouling paint applicators.  Each container size of each product sold should be reported on a separate line of the form.
See the record layout for the data items to include on this form.  If you have manually created a text file or use third-party software that creates text files, see the Text File Specifications.
Form Title: "Annual Report for Restricted Pesticides Sales"

[bookmark: scroll-bookmark-135]Form 26 (also known as Form 44-15-26):  Form 26 is used to report all pesticide applications made by commercial applicators, technicians, anti-fouling paint applicators and apprentices during the reporting year.  Each pesticide application should be reported on a separate line of the form.  Fully certified applicators that supervise apprentices must report applications made by those apprentices.
See the record layout for the data items to include on this form.  If you have manually created a text file or use third-party software that creates text files, see the Text File Specifications.
Form Title: "Applicator/Technician Pesticide Annual Report"

[bookmark: scroll-bookmark-136]Form 26A (also known as Form 44-15-26A): Form 26A is used to submit a list of certified applicators employed by a registered pesticide business or agency or by a non-registered business making pesticide applications (such as a golf course, cemetery, greenhouse, etc.).  All certified applicators who worked for the business during any part of the report year, even if they made no applications, should be included on the form.  Please do not include pesticide apprentices or those who are not certified or are only provisionally certified.
See the record layout for the data items to include on this form.  If you have manually created a text file or use third-party software that creates text files, see the Text File Specifications.
Form Title: "List of Commercial Applicators and Technicians"

[bookmark: scroll-bookmark-137]Form 27 (also known as Form 44-15-27): Form 27 is used by commercial permittees to report all sales of restricted use pesticides or general use agricultural pesticides to certified private applicators in New York State.  Each pesticide sale should be reported on a separate line of the form.
See the record layout for the data items to include on this form. If you have manually created a text file or use third-party software that creates text files, see the Text File Specifications.
Form Title: "Annual Report for Pesticide Sales to Certified Private Applicators"

[bookmark: scroll-bookmark-138]Form Types: The PRL Service Bureau and the DEC have developed four form types that capture all the data required to be reported under the PRL.  All reports submitted to the PRL Service Bureau and the DEC must conform to the record layouts  of these forms or the Text File Specifications.  The four form types are
· Form 25: "Annual Report for Restricted Pesticides Sales"
· Form 26: "Applicator/Technician Pesticide Annual Report"
· Form 26A: "List of Commercial Applicators and Technicians"
· Form 27: "Annual Report for Pesticide Sales to Certified Private Applicators"  


[bookmark: scroll-bookmark-139]Identity File: The identity.txt contains the identity and contact information that you enter into our reporting software and some third-party software products.  You can also create it yourself.  Our software stores the file in the report folder.  Reports that are submitted via email or electronic reports which are mailed to the NYSDEC should include this file.
	There is no need to attach the identity file to reports submitted via the web or using the PRL reporting software.


[bookmark: scroll-bookmark-141]Installation Folder: The default installation folder for all of our software options is: C:\Program Files\NYSPRL. This location is modifiable during installation.  Please note that your report files are not stored here; they are in the report folder.  There is no reason for you to access this folder.  While the blank  Option B templates are stored here, it is simpler to use the Blank Form button on the Registration form to open a new form.

[bookmark: scroll-bookmark-143]Macro: A set of Visual Basic for Applications commands used by the  Option B application to add functionality to the Excel workbooks.

[bookmark: scroll-bookmark-123]Private Pesticide Applicator: Someone who makes private applications of restricted use pesticides for purposes of producing an agricultural commodity in the State of New York.  Private applicators are issued an identification number that starts with the letter "P" followed by 7-digits.  Private applicators are NOT required to file a PRL report.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-124]Pesticide Reporting Law: The PRL requires the annual submission of reports detailing pesticide activities for the prior calendar year. Commercial applicators, technicians, anti-fouling paint applicators and commercial sales permittees (including importers, manufacturers and compounders) are required to submit the annual reports by February 1 of each year,.  See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-131]Pesticide Reporting Service Bureau: The group at Cornell University that has been contracted by the NYSDEC to process the annual PRL reports, provide telephone and email support to the businesses and applicators, create and maintain the PRL web sites and create and maintain the various pesticide reporting options.  Questions not directly related to your PRL report such as questions about your certification or business registration should be directed to the NYSDEC.  We can be  contacted by phone or email.

[bookmark: scroll-bookmark-119]Registered Pesticide Business: Pesticide businesses or agencies registered with the state of New York to make commercial pesticide applications.  Registered businesses are issued a 5-digit identification number. See the NYSDEC web site for more information.

[bookmark: scroll-bookmark-142][bookmark: scroll-bookmark-144]Registration Form (also known as Control Center): The main window of the  Option A, B and C software.  Your contact and identification information is entered here.  You can open a reporting form to enter pesticide data7, upload your report, change the report year, edit your list of products7, change the Report Root and access the program documentation..

[bookmark: scroll-bookmark-146]Report Acceptance Email (also known as second email): The email sent by the Pesticide Reporting Service Bureau after your report has been accepted.  Typically this email is sent out within about one week of submission.  The message contains a list of the applicators from your report who have been credited with reporting for the year.  For pesticide sales businesses it will contain the sales permit numbers credited with reporting.  If you do not receive this email, please contact us.  You will not be credited with reporting for the year until your report has been accepted.

[bookmark: scroll-bookmark-140]Report Folder (also known as Data Directory): The default folder for storing report files that you save and the identity.txt file containing the information entered on the Registration form.  The folder name is PRLyyyy (where “yyyy” is the report year, for ex. PRL2014) and it is created by the PRL Reporting Software Options A, B, and C.  A separate report folder is created for each report year.  You may store your files in another location, but the identity.txt is always saved in the report folder.  We strongly recommend saving to the current report folder, which is the default location used by our software.
The report folder is created by the PRL Reporting Software as a sub-folder of the Report Root, one report folder for each report year.
The PRL Reporting Software displays the current location for the report folder in the upper right corner of the Registration form.
For example, if you create reports for the 2014 report year and have not changed the Report Root location, the default report folder location is: C:\PRL2014.

[bookmark: scroll-bookmark-145]Report Root Folder: The Report Root folder is a location on your computer where all of your NYS PRL files should be saved.  It contains a report folder for each report year, The default setting for the Report Root is your C:\ drive.  The Report Root folder can be changed during installation or by using the Change Report Root menu item on the Tools menu of the Registration form.  For example if you set the Report Root folder to C:\PRL, and you create reports for 2011 and 2012, the C:\PRL folder will contain two sub-folders: PRL2011 and PRL2012.

[bookmark: scroll-bookmark-147]Report Year: The year in which the pesticide applications or sales that you are reporting occurred.  This may be the previous calendar year.

[bookmark: scroll-bookmark-148]Special Local Need Registration: Pesticide product registrations issued by the DEC, per FIFRA (Federal Insecticide, Fungicide and Rodenticide Act), for the following purposes:
To meet an existing or imminent pest problem within New York State for which the Department has determined that an appropriate pesticide product is not sufficiently available which is registered by the USEPA and the Department
or
To allow for the limited registration and use of a product for which the full federally labeled use would result in unacceptable impacts to human health or the environment.
[bookmark: scroll-bookmark-149]SLN Number: The number used to identify a Special Local Need registration.  The format is SLN NY-nnnnnn (where n = numeric digit) (e.g. SLN NY-120001).

[bookmark: scroll-bookmark-132]Submission Number (also known as Processing Number): A 5-digit number issued by the Pesticide Reporting Service Bureau, which identifies a particular report submission.  This number is on the page displayed when you finish uploading your report via our web site or using our  Option A, B or C software.  It is also included in the email the Pesticide Reporting Service Bureau sends when you submit a report via the web, our reporting software or email.
	Please make a note of the submission number; if you contact the Pesticide Reporting Service Bureau, we will need it to access your report.


[bookmark: _Toc256000065][bookmark: scroll-bookmark-152]Legal Requirements
The Pesticide Reporting Law (Chapter 279, Laws OF 1996) requires the annual submission of reports detailing pesticide activities for the prior calendar year. Certified commercial applicators, technicians, aquatic anti-fouling paint applicators and commercial permittees (including importers, manufacturers and compounders) are required to submit the annual reports. Reports are due by February 1 of the year immediately following the reporting year even if no pesticide applications or sales were made. Violations of the Pesticide Reporting Law are subject to penalties of up to $10,000 and could result in the revocation of your applicator certification and/or pesticide business registration.
	Reports that are illegible or do not conform to these instructions will be rejected.


If you have questions regarding the Pesticide Reporting Law and reporting requirements, contact the New York State Department of Environmental Conservation, Pesticide Reporting and Certification Section.
[bookmark: _Toc256000066][bookmark: scroll-bookmark-153]Macro Security Levels
The macro security levels in Excel changed starting with Excel 2007.

Excel 2000 - 2003...
[bookmark: _Toc256000067][bookmark: scroll-bookmark-154]Very High
Only macros installed in trusted locations will be allowed to run. All other signed and unsigned macros are disabled. Not available in Excel 2000. Not recommended for use with Option B. (Option B features will only be available with significant setup effort.)
[bookmark: _Toc256000068][bookmark: scroll-bookmark-155]High
Default setting; only signed macros from trusted sources will be allowed to run. Unsigned macros are automatically disabled. Recommended for Option B, unless you need a lower setting for other reasons.
[bookmark: _Toc256000069][bookmark: scroll-bookmark-156]Medium
You can choose whether or not to enable macros in a particular workbook; digital signatures are not required. Acceptable for Option B.
[bookmark: _Toc256000070][bookmark: scroll-bookmark-157]Low
Enable all macros. Not recommended, potentially dangerous code can run.

	We previously recommended that you change the macro security level to Medium. At that time we were not signing the macros, so Medium security was the best setting compatible with Option B.




Excel 2007 - 2013...
[bookmark: _Toc256000071][bookmark: scroll-bookmark-158]Disable all macros without notification
Not recommended (Some Option B features will not be available.)
[bookmark: _Toc256000072][bookmark: scroll-bookmark-159]Disable all macros with notification
Acceptable (default setting for Option B)
[bookmark: _Toc256000073][bookmark: scroll-bookmark-160]Disable all macros except digitally signed macros
Recommended for Option B.
[bookmark: _Toc256000074][bookmark: scroll-bookmark-161]Enable all macros
Not recommended (potentially dangerous code can run)

[bookmark: _Toc256000075][bookmark: scroll-bookmark-162]PRL Software Installation Guide
[bookmark: _Toc256000076][bookmark: scroll-bookmark-163]System and User Requirements
[bookmark: scroll-bookmark-164]System
Option A - Microsoft Windows 20003 or later
Option B - Microsoft Windows 20003, XP, Vista or 7; Microsoft Excel 20004, 2002, 2003, 2007 or 2010
Option C - Microsoft Windows 20003 or later (as of version 6.1 Option C has been replaced by Option A)
Option D - Microsoft Excel 97, 2000, 2002, 2003, 2007 or 2010
[bookmark: scroll-bookmark-165]User
Windows 2000 and XP -   users must log on using an account with administrator rights.
Vista/Windows 7 - 8 Operating Systems - Depending on how your computer has been set up, you may need to log on as an administrator or provide user name and password for an account with administrator rights in order to run the installation package. It is generally advisable to log on as administrator but may not be required.

[bookmark: _Toc256000077][bookmark: scroll-bookmark-166]Uninstall Previous Versions
We recommend uninstalling previous versions of the software before installing a new version, especially if you are upgrading from a version older than version 6. Uninstalling the old version is not usually required but can help avoid confusion caused by having more than one version of the program installed at the same time.
Uninstalling the software will not affect any saved data files.
Recent versions of the PRL Reporting Software include an “Uninstall” shortcut in the All Programs->Pesticide Reporting group, but for older versions you will need to open the Add/Remove Programs or Programs and Features dialog from the Control Panel and remove the old program from there.
[bookmark: _Toc256000078][bookmark: scroll-bookmark-167]Installation
After you have determined which Pesticide Reporting Software Option to install, download and save the installation file on your computer.
You may be able to run the installation program directly from the web site, but we recommend saving it somewhere on your computer and running it from there. Saving the installation program to your computer allows you to install the program at a later time without re-downloading it from the web site.

Double-click (or right-click and choose Install) the installation file.  There are several steps in the wizard; for some of the steps, you can change the default values. We recommend that you keep the default values unless you have a good, compelling reason to change them.  As you click through the steps, please note the following
· Step 2 provides contact information.  For  Option B installations it also informs you that macros must be enabled in Excel for the application to work properly.
· Step 3 allows you to choose the installation folder.  The default is C:\Program Files\NYSPRL.
· Step 4 sets the Report Root or parent folder for your PRL report folder, which is the folder where your reports will be stored.  The default is the C drive.
	You can change the default Report Root setting here or while running the PRL Reporting Software. The Report Root will contain a folder for each report year; the sub-folders are named PRLyyyy, where yyyy is the report year. For example, if you set the Report Root to C:\PRL and create reports for 2011 and 2012, the C:\PRL folder will contain two sub-folders: PRL2011 and PRL2012.


[bookmark: _Toc256000079][bookmark: scroll-bookmark-168]After Installation
After you complete installation
· The report folder has been created, if necessary.
· There is a program icon  on the Desktop for the software option (either  A, B or C) that you installed. Double-click to run the program.
· There is a program group (on the Start menu or Start Screen) called “Pesticide Reporting” that contains links to start or uninstall the software option (either  A, B or C) that you installed.
[bookmark: _Toc256000080][bookmark: scroll-bookmark-169]Configuration
If you installed  Option B, it is critical that you change the macro security setting in Excel before you start to use the application.  You may also need to enable macros when you open one of the eForms for the first time.
[bookmark: _Toc256000081][bookmark: scroll-bookmark-170]Signed Macros and Excel
Macros in an Excel workbook can be digitally “signed”. This process identifies the publisher of the macros and assures you that the code has not been altered since publication. All current versions of our Option B workbooks include a digital signature from Cornell University.

	If the digital signature has expired, you are probably using an old version of the Option B application. With an expired digital signature, you cannot choose to Trust the publisher.  You will have to set the Medium security setting, which is a less secure setting, for Option B to function correctly.
We recommend that you update to the current version.


[bookmark: _Toc256000082][bookmark: scroll-bookmark-171]Submitting Your Electronic Report
[bookmark: _Toc256000083][bookmark: scroll-bookmark-172]Submission Process
There are several ways to submit your electronic PRL reports to the Pesticide Reporting Service Bureau:
· Service bureau web site
· PRL reporting software
· Email
· Conventional mail
· FTP
You may also mail your paper PRL report to the NYSDEC. 
	See the Report Submission and Report Processing  sections of the process overview page for more information on how to prepare your files for submission and what to expect when and after you submit your files.


[bookmark: _Toc256000084][bookmark: scroll-bookmark-178]Submission Methods
[bookmark: scroll-bookmark-174]Upload with Our PRL Reporting Software
Our PRL Reporting Software Options  A, B, and C all include the ability to upload your report files directly to our server.  If you are using Option A, B or C, the Upload to NYSDEC function is the quickest and easiest way to submit your report.
Some users in tightly controlled enterprise environments might not be able to use the upload function. The web site upload is a good alternative for those users.
When you are done, the software will display a list of the files uploaded and provide you with the submission number of your report.  We will also send you an email with the same information.

[bookmark: scroll-bookmark-173]Upload Through the Web Site
The PRL Web Upload site allows you to upload existing report files or to report that you made no applications. Pesticide sales businesses can upload their reports or report that no sales were made.  The upload pages include help text for each step.
If you are submitting applications or sales files created by PRL Reporting Software Options A or B, the files will be stored in the default report folder, unless you have changed the location.  If you are having trouble locating your PRL Reporting Software report files, see this FAQ.
When you are done, the site will display a list of the files uploaded and provide you with the submission number of your report.  We will also send you an email with the same information.
	If you upload a ZIP file, the Web Upload site will include the contents of the ZIP file in the list of uploaded files that it displays.


[bookmark: scroll-bookmark-175]Email
To submit your report by email, do the following:
1. Compose an email to prlfiles@nysprl.com.
2. Indicate the report year in the subject line.
3. Attach5 the report files to the email.  Report files created by the PRL Software are usually stored in the report folder.
4. You must also attach the file identity.txt.

This file is created by our reporting software and some third-party pesticide software products; you can also create it yourself. Please do not include contact and identity information in the body of your email6 if you have attached the identity.txt file; doing so will slow down processing of your submission.
5. Send your email..

You should receive an email response from prlsupport@nysprl.com acknowledging receipt of your submission.  This message is not an automated reply.  During peak reporting season (roughly mid-December through early February), the receipt email will generally be sent by the next business day; at other times of the year, it will be sent within a few days.

[bookmark: scroll-bookmark-176]Conventional Mail
You may also mail a floppy disk(s), CD(s) or DVD(s) containing your report or send us a paper report.
For electronic reports each diskette, CD or DVD should include a label with the full name of the certified applicator and/or business of origin and a contact phone number.
	Along with your application or sales files, electronic reports must also include the identity file.


[bookmark: scroll-bookmark-179]Mailing Address:
NYSDEC
Pesticide Reporting & Certification Section
P.O. Box 10699
Albany NY  12201-5699
Please do not submit both electronic and paper reports.

[bookmark: scroll-bookmark-177]FTP
PRL report files may be submitted using FTP.  Very few report submissions require FTP transmission. In almost all cases, one of the other submission methods will work as well and probably be more convenient for you. (We have not received any FTP submissions in the last several years.)
To maintain the level of security required, if you wish to use this service, you must contact technical support. Technical support will supply the information necessary to conduct a secure FTP transmission of your report.
[bookmark: _Toc256000085][bookmark: scroll-bookmark-180]Notes
1. [bookmark: scroll-bookmark-181]  It is also possible to run the program by clicking on the executable file, PRL_eForms.exe (Option A), PRL_OptionB.exe, or PRL_OptionC.exe..  The program is installed by default to C:\Program Files\NYSPRL, but you may have changed this setting to another folder during installation.
2. [bookmark: scroll-bookmark-182]Form 26A does not include a copy button because each applicator row should be unique.
3. [bookmark: scroll-bookmark-183]For Windows 2000, some additional updates to Microsoft Windows may be required before the “Upload to NYSDEC” function works.
4. [bookmark: scroll-bookmark-184]Some (minor) functions are disabled in versions earlier than Excel 2003.
5. [bookmark: scroll-bookmark-185]You may need to consult the help for your email program on how to do this, as the procedures can vary quite substantially.  In addition this FAQ may be of some assistance.
6. [bookmark: scroll-bookmark-186]While we may accept reports that were not created using our software or that do not completely comply with our specifications, you must include contact and identity information with all report submissions.  If your software does not create an  identity.txt  file, include contact information (contact name and phone number) in the body of the email.  In addition, your report file(s) must include all certification numbers and commercial permit numbers (pesticide sales businesses only) for your organization.
7. [bookmark: scroll-bookmark-188] Options A & B only
8. [bookmark: scroll-bookmark-189]If this is the first time you have used the program, you will need to fill in some identifying and contact information on the Registration form.
9. [bookmark: scroll-bookmark-190]Excel 2013 may be set to open the Start Scree n when started.  If this is the case you will need to open a blank workbook in order to see the File menu.
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File Types _Help

lease save and close all report files before uploading. NOTE: This version of the software
automatically sends your identity information. You do not need to specify the identity txt
file here. If you email your report instead, remember to attach identity bt to the email in
addtion to the report files

Step 1. Uncheck any files from the list below that you DO NOT want to upload.

Step2. Click the "Upload Report to DEC” button.
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Step 2. Upload Report to DEC

Cancel
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Your files are being uploaded. Please be patient.

PRL Report for 2014
Upload Succeeded!

Your files were uploaded to PRL Support successfully. Your report has been assigned a submission mumber of 58035,
Please inciude this numiber in all inquires about your report
We received the following files:

File Name Length Compliant
A5432100.0 59 Yes
PC198765400.xt 88 Yes
SR0000100.txt 75 Yes
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Change Reporting Year

Select the new Report Year and click "OK".  [o014  +] [ OK

Note: Changing the Report Year will not Cancel
change the year in existing reports —
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